
The Villages Computer Club 

VCC meeting on Friday Oct 5th , La Hacienda at 1:00PM 

This week's program will feature a presentation by Fred Benson on 

Using Skype  

Calling friends and family anywhere in the world. Treat them to some 

special Skype visual effects.  

 

Following the presentation will be refreshments, 50/50, door prizes and 

a problem solving session. 

 

If you have a computer problem you can't resolve, fill out the 

Troubleshooting Request form found a t 

http://thevillagescomputerclub.com/ and bring it to the meeting. 

 

Sign up to be on the VCC email list at the VCC home page (above) 

 

For more information on the VCC please reference the clubs web site 

(above) 

Guests are always welcome as long as they have . 

For information, email Paul Rabenold at TVCC.Pres@gmail.com 

 

If you have not done so check out The Villages Computer Plus Club 

meetings at http://www.villagescomputerplus.com/meetings.html  

**************************************** 

Great news!!!!!!  
"SCOtutor for iPad" is now available in the app store and is free. This a must app!!! 

This app gives you detailed instructions for your iPad and IOS 5.1.1. This app was 

available earlier and was discussed, but was pulled from the app store and is 

available now. Make sure you download it.  
IOS 6 Manual 
If you have IOS 6, go to the Apple website, click on Support, click on iPad picture, 

click on manuals picture and there is the IOS 6 user manual. 



Don't forget tomorrow's meeting at Colony Cottage, 1:30pm. 
Art Fenn,430-0252 
****************************************************** 

Win 7 Font Default in Win Mail 

To permanently set the default font face and color for new messages in Windows Live Mail, 

Windows Mail or Outlook Express:  

• Select Tools | Options... from the menu in Windows Live Mail, Windows Mail or 
Outlook Express.  

o In Windows Live Mail, you may have to hold down the Alt key to see the 
menu bar. 

• Go to the Compose tab.  
• Under Compose Font, click the Font Settings... button next to Mail:.  
• Choose the desired font and color.  
• Click OK. 

Does The Font Still Look Unnaturally Small? 

If you have changed your default font to a larger type but still can barely see what you 
are typing, it may be your reading font settings' fault. Check in the main Windows Mail 
or Outlook Express window under View | Text Size.  

Default Stationery Overrides Default Font 

Note: to make sure Windows Live Mail, Windows Mail or Outlook Express is using the 
font you just specified no default stationery must be defined or its font settings will be 
used no matter what you specified under Font Settings.... 

Suggested Reading 

• How to Change the New Mail Sound in Outlook, Windows Live Mail, Windows 
Mail... 

• How to Create a Signature in Windows Live Mail, Windows Mail or Outlook 
Express 

• How to Change the Font Size of the Windows Mail or Outlook Express Message 
List 

Revised 10 1 2012 JMM 

********************************************** 

Windows Mail Step by step Setup 



Once you have collected the required information for each e-mail account, you can start 

setting up Windows Mail. Here’s how to add an e mail account in Windows Mail: 

1. Open Windows Mail by clicking the Start button , clicking All Programs, and then 

clicking Windows Mail.  

2. Click the Tools menu, and then click Accounts. 

3. Click Add. 

After you click Add on the Internet Accounts screen, Windows Mail will ask what 

type of account you want to add 

4. Click E-mail Account, click Next, and then follow the instructions. 

After you are done entering all the information for one e-mail account, repeat the 

process for each e-mail account you want to set up, if you want to add more than the 

one account. 

Note 

During setup, you'll be asked to pick a display name. You might want to enter your 

actual name here rather than your e-mail address, since this is the name that recipients 

will see when you send them an e-mail message. 

Importing your e-mail, & contacts,into Windows Live Mail 

Ready to install Windows 7? Great! One thing you'll need to know before you begin, though, is that some 

familiar programs—like Outlook Express, Windows Mail, Windows Calendar, and Windows Address 

Book—aren't included in this version of Windows. But don't worry, you've got a couple of new options for 

getting to your e-mail, contacts, and calendars. 

You can use a free online service like Windows Live, which is a convenient way to go because you can 

access all your information from any computer with an Internet connection. 

But if you want to have all your data on your PC even when you're offline, you'll need to install a new 

desktop e-mail program, such as Windows Live Mail, part of Windows Live Essentials, a free suite of 

programs designed to link what you do on your desktop with what you do online.  

Once you've installed Windows Live Mail on your PC, you'll be able to import your existing e-mail 

messages, calendars, and contacts from Outlook Express (if you're upgrading from Windows XP or earlier) 

or Windows Mail (if you're upgrading from Windows Vista). You can also set it up to work with Hotmail 

and other e-mail providers—like Gmail, Yahoo! Mail Plus, or your Internet service provider (ISP)—to keep 

track of all your e-mail accounts in one place. To learn more about Windows Live Mail, see So long, 

Outlook Express! 



Making the switch to Windows Live Mail 

The steps you'll need to follow to get started with Windows Live Mail will depend on what type of 

Windows 7 installation you're doing—an upgrade or a custom installation. To find out more about 

installing Windows 7, see Installing and reinstalling Windows 7. To download Windows Live Mail, go to the 

Windows Live Mail website. 

Error! Hyperlink reference not valid.  

 If you're upgrading to Windows 7 from Windows Vista

Using the Upgrade option during Windows 7 installation will keep your files and settings from Windows 

Vista in place—including your e-mail, contacts, and calendars. Then, when you start Windows Live Mail for 

the first time, it will automatically import your data. 

If you're already using Windows Live Mail in Windows Vista, good news: You won't have to do anything 

special to get up and running after you finish upgrading to Windows 7. Just open and use it as you 

normally do. 

 If you're doing a custom installation of Windows 7

Choosing the Custom option during installation doesn't preserve your programs, files, and settings. That 

includes your e-mail, contacts, and calendars—whether you're using Windows Mail, Outlook Express, or 

another program. So you'll need to back up your e-mail, calendars, and contacts—along with any other 

files and settings you want to preserve—by copying them to an external hard disk or a USB flash drive. 

We recommend using Windows Easy Transfer, a free download, to do this backup. If you're upgrading 

from Windows XP, see Upgrading from Windows XP to Windows 7. If you're upgrading from Windows Vista, 

see Upgrading from Windows Vista to Windows 7 (custom installation). 

After Windows 7 is installed on your PC, you can use Windows Easy Transfer again to move all your files 

and settings back to your computer. Then, after you download and install Windows Live Mail, you can 

import your data. 

Importing e-mail and contacts into Windows Live Mail 

After you've moved your e-mail and contacts from the external hard disk or USB flash drive back to your 

PC and installed Windows Live Mail, you're ready to import your data into Windows Live Mail. 

Error! Hyperlink reference not valid.  

 To import e-mail

1. Open Windows Live Mail by clicking the Start button . In the search box, type Windows Live Mail, 

and then, in the list of results, click Windows Live Mail. 

2. Click the File menu, and then point to Import.  

3. Click Messages, and then choose the e-mail program from which you want to import e-mail 

messages. 



4. Click Next, and then follow the on-screen instructions. Your imported messages will appear in the 

folder list under Storage folders. 

 To import contacts

1. Open Windows Live Mail by clicking the Start button . In the search box, type Windows Live Mail, 

and then, in the list of results, click Windows Live Mail. 

2. In the lower-left corner of the Windows Live Mail window, click Contacts. 

3. Click the File menu, point to Import, and then click the type of address book that you want to 

import. 

If prompted, browse to the file that contains the contact information that you want to import, click 

it, and then click Open. 

******************************************************************* 

Centurylink email through Windows Mail 

 

For your Centurylink email, are you using it through Windows Mail or Outlook? 
For either one sending mail requires an SMTP setting of smtp.centurylink.net and the 
port number of 587 
You can use the following instructions to configure Windows Live Mail to check your 
CenturyLink email address 

1. Open Windows Live Mail. Select the Accounts tab from the top of the 

page. From there, select the Email button. 

2. Enter in your full email address under the Email address heading. Enter 

the password below that, and click the "Remember this password" box. 
Enter in whatever display name that you would like to use. Make sure to 

check the "Manually configure server settings" box. 

3. The incoming server is the provided POP server: pop.centurylink.net and 

the port number is 995. Select POP from the server type, enter the server 
address as provided, as well as the port number. Do check the "Requires a 

secure connection (SSL)" box. Set "Authenticate using" to Clear Text. 
Change the Logon user name to your full email address. 

4. The outgoing server is the provided SMTP server: smtp.centurylink.net 

and the port number is 587. Type this information in the appropriate boxes. 
You will check "Requires a secure connection (SSL)", and check "Requires 

authentication". 

5. Click Next and your account is set up for Windows Live Mail 2011 

*************************************************************
**** 

Centurylink Mail 
 

• Setting your user preferences 



• Changing your user preferences 

• Restore default preferences 

• New mail notifications 

• Creating away messages 

• Saving messages you send 

• Creating personas 

• Changing your default time zone 

 

Setting your user preferences (Back to Top) 

Your default user preferences are configured when your account is created. These 
options define how your mailbox, address books, and calendar applications work. You 
can also set up your personal email identities and POP accounts and select a theme for 
your mailbox. 

You can change the settings from the Preferences tab. If an option described here is not 

visible in your view, it is not available for your account.  

You can set preferences in the following tabs. Click on the word for a detailed description of the tab. 

• General 

• You are logged into the standard web client. To set this to be the default Client Type 
when you log in, select Advanced. 

• Advanced offers the full set of Web collaboration features. This Web Client works best 
with newer browsers and faster Internet connections.  

• Standardis recommended when Internet connections are slow, when using older 
browsers, or for easier accessibility. 

• In Theme select the background color for your mailbox interface. 

• If the time zone displayed here is not correct, select the defaulttime zone for your 
account. This determines the date and time for messages that you send or receive and 
the time to display for Calendar appointments. This can be different from your computer 
time zone configuration.  

• In Search Settings, you can choose to automatically include the Spam and Trash folders 
in any search you perform. By default these folders are not searched. 

• In Search Language, check Always Show Search String to show search string details in 
the search text box.  

• Enable Always show selection checkboxes to display a checkbox for each item in the 
Content pane. Use the checkbox to select one or more items to perform the same action 
on, such as delete, move, mark as read/unread. 

• Mail 

• Select how many items (messages or conversations) to display per page. The default is 
to display 25 items per page, but you can select 10, 50, or 100 items per page. 

• Select how you want to group your mail, by conversation or message. If you have the 
Conversation feature, Conversations is the default. 



• Polling interval is how often your computer checks for new mail. The default is every 5 
minutes. 

• Specify whether to view mail as HTML, for messages that have been formatted as HTML. 
Turning this off causes mail to be displayed as plain text, showing the HTML tags 
themselves rather than applying them as markup. 

• Message Preview options 

• Set whether to show the reading pane when viewing mail. The default is to 
always show the reading pane. 

• Of enabled, the client displays snippets of messages in email list. When the 
cursor is over the subject of a message, the first few words of the message are 
displayed. 

• If enabled, double-click opens messages in new window  

• Enable Images to download pictures automatically to your HTML email message. When 
this is enabled, you do not need to click the display image message to see the image. 

• Default Mail Search defines the search to execute when you log in. The default search is 
your Inbox. When you log in, the results of your Inbox display. You can change this field 
to have another folder, tag, or a saved search displayed when you first open the 
CenturyLink™ Webmail Client. See Query language description for the syntax. Enable 
and specify an address to send notifications that you have received new mail.  

• Specify an address to forward your email to. You can have the original email deleted from 
your CenturyLink™ mail mailbox.  

• Specify whether to send an auto-reply message to incoming mail. This is frequently used 
as an away message or vacation message saying that you are out-of-office, and what 
the message should say.  

• Configure the Messages from me section to handle messages you send that include your 
address as one of the recipients of the message or that are included in an address, such 
as a mailing list that includes you. 

 

• Composing 

• Set which text editor you want as the default, either HTML or plain text.  

• Set the default font settings to be used when using HTML to compose in Mail and 
Calendar. You can define the font style, size and color to use as your default style. Arial, 
12 point black is the default. 

• Always compose in new window opens a new compose window, separate from your 
CenturyLink™ mail mailbox, when you compose a message. You can view and navigate 
your mailbox while the compose window is open. 

• Messages you compose are automatically saved as a draft every few minutes. If you 
would prefer not to have this automatically saved, disable the feature. 

• Select whether to include the original text in the body of your reply message. You can 
choose to include original text, not include it, include it as an attachment, include it in the 
body with a prefix that you choose, or include only the most recent message. (In other 
words, it will quote only what was written by the person who sent the message, and not 
previous text.) 

• Specify whether to prefix each line with > of | for the previous email messages that are 
forwarded or replied to, if you chose to quote original text. 



• By default, the Save copies of messages to sent folder is enabled. Copies of messages 
you send are saved to your Sent folder.  

• Specify how to include the original text of a message when you forward a message, in 
the body of the message, in the body with a prefix, or as an attachment. 

• Signatures 

You can create signatures for your email messages. Your signature can include your name and 
additional closing text to the maximum number of characters that your account allows. If you 
create multiple identities, you can create different signatures and assign them to specific 
addresses. 

• Enter the signature that should appear on your email messages.  

• Specify the placement of your signature in your email messages: either add the signature 
below all messages in the email or have the signature added at the end of your 
composed, replied to, or forwarded text.  

• Address Book 

• Enable the feature to automatically add addresses to your address book when you send 
mail. If this is enabled, addresses are saved to your Email Contacts folder. 

• Select whether you would prefer to view contacts as a list or as business cards. 

• Select the number of contacts to display per page. The default is 25. 

• Import Contacts to your Contacts list. The file to import must be in a comma-delimited 
format. 

• Export your contacts list. The file exports in a coma-delimited format. 

 

• Accounts 

The accounts tab is used to create and manage your personas. Persona is the mail identity used 
in the From field of email messages you send. 

The default style is defined in the primary identity. When you create new identities, you can use 
the same settings as the Default Identity or you can set different preferences.  

The Add External Account button lets you identify your external POP/IMAP accounts so that this 
web client can retrieve email from your other accounts. You can also set up so that replies to 
those messages use the corresponding POP/IMAP address.  

• Mail Filters 

Use the Mail Filters tab to define mail filtering rules. To learn how to set up mail filter rules, see 
How filtering works. 

• Calendar 

• Select how you would like to view your CenturyLink™ mail calendar. The default is by 
work week. 

• Specify which day of the week should be the first day of the week in your calendar. 

• If you travel between time zones, you may want to select to show the time zone list in the 
appointment view.  

• If you create many appointments without attendees, checkUse the QuickAdd dialog. 

• A mini-calendar is displayed in Calendar. You can enable mini-calendar to be visible from 
any view. 



• Set the number of minutes before an appointment to be reminded. The default is five 
minutes. 

• Import and export other calendar programs. 

• Shortcuts 

Keyboard shortcuts let you use the application without going to the mouse. A large number of 
shortcuts is available. You can also create custom shortcuts by assigning numeric aliases to 
folders, tags, and saved searches. 

• The Shortcut List shows all the existing keyboard shortcuts.  

• The Mail Folder Shortcuts tab is used to create a shortcut to quickly go to your email 
folders and to move a message to that folder. You select the folder and assign a number 
to it. For example, if you assign 3 to the Inbox folder: From anywhere in your mailbox, 

typing v3 will move you to the Inbox. Selecting an item and type .3, will move the item to 

the Inbox. 

• The Saved Search Shortcuts tab is used to create shortcuts to quickly access Saved 
Searches. You select a saved search and assign a number to it. For example, if you 
assign 3 to your favorite search, then from anywhere in your mailbox, you can type s3 to 
quickly run that search. 

• The Tag Shortcuts tab is used to create shortcuts to quickly access all items with a 
specific tag or apply a tag to a message or contact. You select a tag and assign a 
number to it. For example, a tag called Follow up is assigned 3. From anywhere in your 
mailbox, you can type y3 to see all items marked with Follow up. Select an item and type 
t3 to tag that item with Follow up. 

You can assign any number, but it cannot be repeated within a shortcut tab. 

 

Changing your user preferences (Back to Top) 

Your default user preferences are configured when your account is created. These options define how 
your mailbox, address books, and calendar applications work.  

You can change the settings from the Preferences tab. If an option described here is not visible in your 
view, it is not available for your account.  

The general direction for changing your preferences is as follows: 

1. Click Preferences. 

2. Click the tab containing the preference you want to change. See the Help topic for each of these 
tabs for specific details 

3. Change the settings. 

4. Click Save. 

 

Also see Setting your user preferences 

 

Restore default preferences (Back to Top) 

On each of the Preferences tabs except for the Mail Filter tab, the Restore Defaults button on each page 



resets any changes for that page to the default system settings that were in effect when you first logged in 
to your new CenturyLink™ mail account. You must click Save in order to commit these changes. 

 

New mail notifications (Back to Top) 

You can configure your mail options to be notified at another email address when you receive mail to your 
CenturyLink™ mail mailbox. This feature may be useful if you do not receive a lot of mail to your 
CenturyLink™ mail account, but when you do receive mail, it's important enough to require a timely 
response. 

To set notification: 

1. Click the Preferences tab. 

2. Click the Mail tab. 

3. In the Receiving Messages section, check Send a notification message to, and enter the email 
address. 

4. Click Save. The notification feature is enabled immediately. 

 

Creating away messages (Back to Top) 

a  
This feature is also known as an out-of-office auto-reply message. You can set a vacation message that 
automatically replies to people who send you messages when you are out of the office for an extended 
period of time. That message is sent to each recipient only once, regardless of how many messages that 
person sends you during the designated vacation period. 

To set a vacation message: 

1. Click the Preferences tab. 

2. Click the Mail tab. 

3. In the Receiving Messages section, check Send auto-reply message. 

4. In the text box, enter the message to be sent, such as "I am currently out of the office and am 
checking voice mail but not email. I will return on August 1, 2007." 

5. Set the start and end dates for using this message.  

6. Click Save. The away message feature is enabled immediately.  

 

Saving messages you send (Back to Top) 

The Sent folder contains copies of mail messages that you have sent. You can delete your copies at any 
time. 

By default, Save to Sent is enabled. You can change this from the Preferences, Compose tab. 

 



Creating Personas (Back to Top) 

Creating different mail identities, called personas, allows you to use multiple email addresses from your 
mailbox. You might want to do this to manage different roles in your job and personal life from this single 
email account.  

To create a persona open the Preferences tab and configure the following: 

1. On the Accounts tab, click Add Persona. 

2. In the Persona Settings section enter a name for this persona. This name is used to identify the 
persona in the From list when composing an email. It does not appear in the email message. 

3. In the text box below From: type the name that should appear in the From field of your outgoing 
email messages (for example, John). This is the friendly name that is shown before your email 
address. In the second box, select the email address to send messages from. Your account 
configuration may let you create an address.  

4. If replies should be sent to a name and address different from that which you configured in From, 
check Reply-to. Enter the name and address that should receive replies for this identity. For 
example, replies to training messages John sends should be sent to Team Training at 
training@xample.com.  

5. You can select a signature to use for this persona. If you have not created the signature, you can 
come back and edit this persona later. If you do not want the signature to be applied 
automatically, select Do Not Attach Signature. 

6. If you want messages in specific folders to automatically use this persona, check Replying to or 
forwarding messages in folder(s). Click the folder icon to select one or more folders from the list 
of existing folders or to create a new folder. Type a comma or semi-colon to separate folders 
entered in the box. 

7. Click Save to save this persona.  

If you need to create the signature, go to the Signature tab after you click Save. See Using a signature. 

 

Changing your default time zone (Back to Top) 

The default time zone setting that is displayed in the Preferences>General tab is used to localize the time 
for received messages and calendar activities in the standard web client.  

When using the standard web client, the time zone on the computer is not used to set the time a message 
is received or for calendar activities; the time zone setting in the Preferences>General tab is. However, 
when using the advanced web client, the time zone setting on the computer is used to as the time stamp 
for received messages and for calendar activities, not the time zone setting on the General tab. 

 

• Because the advanced web client and the standard web client do not use the same time zone 
source to render messages, you may notice that the same message has a different time when 
displayed in one or the other client. You can avoid this by having the computer time zone and 
the web client time zone set to the same time. 

 

 
**********************************************************************************  

 



Comcast Manual Instructions  
 
 
These instructions will allow you to configure your computer and applications for 
Comcast Cable High-Speed Internet. 
 
E-mail Settings: 

1. POP3 (Incoming Mail) Server: mail.comcast.net  
2. SMTP (Outgoing Mail) Server: smtp.comcast.net  
3. Your E-Mail address: e-mail ID@comcast.net  

News Groups: Netnews.Comcast.net 
 

Configure Outlook Express for the First Time: 
(In XP or prior versions of Windows. Win 7 does not come with OE, but with Windoes 
Mail) 

1. Open Outlook Express by clicking on the icon located on your desktop or click 
the ENVELOPE icon wrapped with a blue arrow located on your toolbar next to 
the START button. If this is your first time launching Outlook Express, the 
Internet Connection Wizard will open to guide you through configuration. If you 
do not see this window, please proceed to Reconfiguration of Outlook Express.  

2. In the Internet Connection Wizard, type your name in the Display name field as 
you would like it to appear when you send e-mail and then click NEXT  

3. Enter your e-mail address in the field provided in the format: e-mail 
ID@comcast.net  

4. Click NEXT  
5. In the Incoming Mail (POP3, IMAP or HTTP) server field enter: mail.comcast.net  
6. In the Outgoing Mail (SMTP) field enter: smtp.comcast.net  
7. In the News (NNTP) server field, type: netnews.comcast.net  
8. Click NEXT  
9. Enter your username in the POP Account Name Field and your password in the 

password field (If you do not wish to supply your password each time you check 
for incoming mail, verify that the REMEMBER PASSWORD box is checked)  

Click NEXT and then select FINISH 
 

Reconfigure Outlook Express: 
If you have an existing Outlook Express account that needs to reconfigured to retrieve 
e-mail from the Comcast server, follow these steps: 
 

1. Open Outlook Express and select the Tools menu  
2. Click ACCOUNTS  
3. Click the Mail tab to make it the active window  



4. Click to highlight the account name you want to verify or reconfigure and then 
click the Properties tab 
Note: If you do not see the e-mail account listed, remove any accounts in the 
dialog box that are not being used by selecting the account and clicking 
REMOVE. Then click ADD and select MAIL. You may now go to First Time 

Configuration of Outlook Express to proceed. If you do see the e-mail account 
listed, selected the account, click PROPERTIES and continue with the steps 
below.  

5. Verify that the General tab is displayed. If you wish to change the Account name 
to a more easily recognizable (for example, Comcast), change the name 
displayed in the Mail Account field  

6. If you wish to edit your name and e-mail address settings, use the fields provided 
under User Information  

7. Click APPLY  
8. If you do not wish to edit information on other property tabs, Click OK  
9. To edit the mail server address information, select the SERVERS tab  
10. Verify that the Incoming Mail (POP3) field displays: mail.comcast.net  
11. The Outgoing mail (SMTP) field should display: smtp.comcast.net  
12. The Account name should display your username  
13. If you have elected to save your password or if you are entering your password 

in this field for the first time or replacing it, it is displayed as asterisks  
14. To verify that your e-mail is removed from the Comcast mail server, select the 

ADVANCED tab and make sure the box beside LEAVE A COPY OF MESSAGE 
ON THE SERVER is not checked  

When done, select APPLY and then click OK 
 
Configure E-mail in Microsoft Outlook 2000 in Windows: 

1. Open Outlook  
2. On the TOOLS menu, click SERVICES  
3. On the Services tab click INTERNET E-MAIL INFORMATION SERVICE and 

then click PROPERTIES  

If Internet E-mail is not listed, click ADD, then click INTERNET E-MAIL and click OK  

4. On the General tab in the MAIL ACCOUNT FIELD type a name for this account  
5. In the NAME field type your full name  
6. In the E-MAIL ADDRESS field type your username@comcast.net  
7. In the REPLY ADDRESS field type your username@comcast.net  
8. On the Server tab in the OUTGOING MAIL (SMTP) field type smtp.comcast.net  
9. In the INCOMING MAIL (POP3) field type mail.comcast.net  
10. On the Incoming Mail Server area type your username@comcast.net in the 

ACCOUNT NAME field  
11. In the PASSWORD field type your password  
12. On the Connection Tab choose CONNECT USING MY LOCAL AREA 



NETWORK (LAN)  
13. Click OK 

 

DataMask by AOL - An AOL Member Benefit 

What is DataMask by AOL? 
DataMask by AOL is a simple and secure software that disguises 
your personal data from cyber crooks and threatening websites by 
hiding your keystrokes (anti-keylogging) and diverting you away 
from sites designed to steal and use your personal information 
(anti-phishing). For more information, visit datamask.aol.com. 

Is DataMask by AOL free? 
DataMask by AOL is included in certain AOL Advantage Plans at 
no additional cost. 

How do I download and install DataMask by AOL? 

To download DataMask by AOL, visit datamask.aol.com and click 
Download Now. For step-by-step installation instructions, visit our 
article Installing DataMask by AOL. 
Alternatively, you can activate DataMask by AOL from 
mybenefits.aol.com. Simply sign in with your Username or Email and Password. 
Next, locate the DataMask by AOL plan feature and then click 
Download Now. Follow the on-screen instructions to begin installing. 

How does DataMask by AOL work? 
Once downloaded, DataMask by AOL uses patent-protected 
technology to hook into your computer browser protecting data 
entry on all webpages—at all times. DataMask by AOL protects 
all browsers, including the AOL Desktop browser. 

Am I eligible for DataMask? 

Certain AOL Advantage Plans are eligible for DataMask by AOL. 
To view what your AOL Advantage Plan has to offer, check out 
your personalized AOL MyBenefits page at mybenefits.aol.com. 

*****************************************************

************************ 



With all the negative news invading our homes these days, we need a 

bit of comedy for balance. 

Jean Robertson can really tell a story.  
In this one they are out camping in a tent.  
Left Brain, her husband decides to get  
frisky she says. Listen to the story and  
you will know why she is such a great comedian... 
 

http://stg.do/7HBc 

****************************************** 

 

 

 

 
 

JmaxJmaxJmaxJmax  

Jmax's Website http://www.jmaxbits.com/ 
Jmax Bits Newsletter is now posted each Monday & Thursday on the website. 
You have the option for a .pdf or a .rtf file. 
 
1.For help with a computer problem, put HELP in the subject line and give me info 
about the computer you're using, if you know it.  
 
2.To view or print Jmax Bits Good Services List in the Villages area, click link 
www.jmaxbits.com 
 
3. To sign up for the non-computer newsletter, send an email to 
VLGSClassifieds@aol.com. Put SUBSCRIBE in the subject line. To send an Ad, 
place AD in the subject line. 
 
4. The Villages Computer Club's web page: Click here: Welcome To The Villages 
Computer Club 
To add your name to the VCC announcements list, send email to TheVCC-
subscribe@yahoogroups.com 
 

5. Fred Benson's website www.thevillagescomputerbasics.com  



 


